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1 System Description

This document presents the implementation details of a digitally controlled 2-Phase Interleaved Power
Factor Correction (ILPFC) converter. A C2000 Piccolo-B control card and a 700W ILPFC EVM are used to
implement the complete system.

With various regulations limiting the input current harmonic content, especially with the IEC 61000-3-2
standard that defines the harmonic components that an electronic load may inject into the supply line, a
power factor correction (PFC) stage has become an integral part of most rectifier designs. The PFC stage
usually forms the front end of an isolated ac-dc rectifier system as shown in 图 2.

图图 2. Isolated AC-DC Rectifier Block Diagram

The PFC converter provides power to non-linear loads from the AC mains while maintaining AC input
current of the same wave-shape and phase of that of the AC mains voltage. At the same time, the PFC
converter regulates its output DC voltage in order to provide a regulated high voltage bus to any
downstream DC-DC converter connected to its output. The downstream DC-DC converter is usually a
phase shifted full bridge (PSFB) converter which converts the high DC bus voltage from the PFC stage to
a lower voltage such as, +12V, or, an intermediate distribution voltage, typically closer to 48V. The phase
shifted full bridge (PSFB) stage provides the desired voltage translation and the high frequency isolation
for this offline rectifier system. This document focuses on the implementation detail of the PFC stage.
Specifically, it presents the hardware design and the corresponding software to control a 2-phase
interleaved power factor correction (ILPFC) front end.

This PFC EVM comes with a Piccolo-B control card. However, the controller resources used for the PFC
implementation shows that Piccolo EL can also be used to implement full control of the PFC stage.
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2 Introduction

The function of a PFC stage is to convert the AC mains voltage to a regulated DC bus voltage while
drawing a sine wave input current in phase with the AC input voltage. Typically, this is implemented using
a bridge rectifier followed by a boost PFC stage. A C2000 piccolo microcontroller with its on-chip PWM
and ADC modules is able to implement complete digital control of such interleaved PFC (ILPFC) system.

2.1 PFC Stage Implementation

图 3 illustrates a C2000 controller based interleaved PFC converter control system. The input AC voltage
is applied to the PFC converter through the input EMI filter, followed by an inrush current limit and a bridge
rectifier. The PFC stage consists of two interleaved boost converters each operating at 200kHz and phase
shifted by 180 deg.

图图 3. Interleaved PFC Converter Control Using the C2000 Microcontroller

Inductor L1, MOSFET switch Q1 and diode D1 together form one of the boost stages while, L2, Q2, and
D2 form the other boost stage. A capacitor Cb at the boost converter output acts as an energy reservoir
and this, in conjunction with closed loop PFC control, provides regulated dc voltage to the PFC load RL.

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDU249.pdf


Introduction www.ti.com.cn

4 ZHCU189–April 2014

TIDU249 — http://www-s.ti.com/sc/techlit/TIDU249
版权 © 2014, Texas Instruments Incorporated

具有功率计量测试结果的两相交错式 PFC 转换器

图 3 indicates all the interface signals needed for full control of this interleaved PFC converter using a
C2000 micro-controller (MCU). The MCU controls the hardware using four feedback signals and two PWM
outputs. The signals that are sensed and fed back to the MCU include, the line and neutral voltages
(Vin_L & Vin_N), the PFC input current(Irect), and the DC bus output voltage (Vbus). These sensed
signals are used to implement the voltage and current control loops for this IL PFC converter. For phase
current balancing two PFC switch currents (Isw1, Isw2) can also be monitored. However, this feature is
not implemented in this EVM

The dc bus voltage Vbus, sensed through one of the ADC channels, is compared against the reference
bus voltage Vref. The error signal Ev is input to the voltage loop controller Gv which regulates the bus
voltage at the reference level so as minimize Ev. The voltage controller Gv has the form of a two pole two
zero (2P2Z) compensator. The output of Gv, denoted by the letter A in 图 3, is proportional to the amount
of power transfer by the PFC converter. This output A is then multiplied by three parameters, indicated by
B, C and Km in 图 3, in order to form the reference current command Iref for the PFC current control loop.
The signal indicated by B is the inverse of the square of the RMS input voltage which also enables fast
feed-forward control of the PFC system. The signal C is proportional to the rectified input voltage, which
modulates the voltage controller output A such that the PFC input current has the same shape as that of
the PFC input voltage. The parameter Km is the multiplier gain which is used to adjust the range of Iref
corresponding to the full input voltage range of the PFC converter. The output of the multiplier block
provides the reference signal Iref that is used for control of the total average inductor current, i.e., the PFC
input current. This reference current command Iref for the PFC current control loop is compared against
the sensed PFC input current Ii sensed through one ADC channel. The resulting current error signal Ei is
then input to the current loop controller Gc which generates the PFC duty ratio command d such that the
PFC input current tracks the reference current Iref.

In addition to implementing the voltage and current loop controllers, C2000 MCU also uses the sensed
line and neutral voltage signals to determine the polarity of the input voltage (+ve & –ve half cycle) and
calculates the rectified input voltage, the RMS input voltage, RMS input power and the input line
frequency. All these time critical functions are implemented in a fast sampling loop enabled by the C2000
Micro-controller high speed CPU, interrupts, on chip 12-bit ADC module and high frequency PWM
modules. A detailed description of the software algorithm is provided in the following chapters.

2.2 IL PFC Electrical Specifications

Following lists the key highlights of the C2000 IL PFC EVM:

• Input Voltage (AC Line): 100V (Min) to 260V (Max), 47~63Hz

• Rated Output Voltage 390Vdc

• Rated Output Power 700 Watts @220V input, 550W@110V input

• Full Load efficiency: 97% @220V input

• Power factor at 50% or greater load – 0.98 (Min)

• Input Power Monitoring

• PWM frequency 200kHz

http://www.ti.com.cn
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3 Software Overview

3.1 Software Control Flow

The CCS project for C2000 ILPFC mostly makes use of the “C-background/ASM-ISR” framework. The
main fast ISR (100kHz) runs in assembly environment. A slower ISR (10kHz) is also run from C
environment. This slow ISR is made interruptible by the fast ISR.

图图 4. IL PFC Software Flow Diagram

The CCS project uses C-code as the main supporting program for the application, and is responsible for
all system management tasks, monitoring, decision making, intelligence, and host interaction. The
assembly code is strictly limited to the fast Interrupt Service Routine (ISR), which runs all the critical
control code. Typically this includes reading ADC values, input line cycle polarity detect, sensed line volt
rectification, control calculations, and PWM updates. The slower ISR in the C environment calculates the
RMS input voltage, RMS input current, RMS input power and frequency of the input line voltage. 图 4
depicts the general software flow for this project.

The key framework C files used in this project are:

InterleavedPFC-Main.c – this file is used to initialize, run, and manage the application. InterleavedPFC-
DevInit_F2803x.c – this file is used for 2803x controller initialization. A 2803x control card is provided with
the IL PFC EVM. This file is responsible for a one time initialization and configuration of the F280xx
device, and includes functions such as setting up the clocks, PLL, GPIO, etc.

The fast ISR consists of a single file:

InterleavedPFC-DPL-ISR.asm – this file contains all time critical “control type” code. This file has an
initialization section (one time execute) and a run-time section which executes at half the rate (100kHz) as
the PWM time-base(200kHz) used to trigger it.

The slow ISR consists of a single file:

http://www.ti.com.cn
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SineAnalyzer.h – this file contains code for calculating the RMS voltage, RMS input current, RMS input
power and frequency of the input line voltage. This file has an initialization section (one time execute) and
a run-time section which executes at 10kHz rate.

The Power Library functions (modules) are “called” from the fast ISR framework.

Library modules may have both a C and an assembly component. In this project, seven library modules
are used. The C and corresponding assembly module names are:

表表 1. Library Modules

C configure function ASM initialization macro ASM run-time macro
PWM_2ch_UpDwnCnt_Cnf.c PWMDRV_2ch_UpDwnCnt_INIT n PWMDRV_2ch_UpDwnCnt n
ADC_SOC_Cnf.c ADCDRV_1ch_INIT m,n,p,q ADCDRV_1ch m,n,p,q

PFC_InvRmsSqr_INIT n PFC_ InvRmsSqr n
MATH_EMAVG_INIT n MATH_EMAVG n
PFC_ICMD_INIT n PFC_ICMD n
CNTL_2P2Z_INIT n CNTL_2P2Z n

The modules can also be represented graphically as shown in 图 5.

图图 5. C2000 ILPFC Software Modules

注注: Note the color coding used for the modules in 图 5. The blocks in ‘dark blue’ represent the
on-chip hardware modules in C2000 controller. The blocks in ‘blue’ are the software drivers
associated with these modules. The blocks in ‘yellow’ are part of the computation carried out
on various signals. The controllers used for voltage and current loops have the form of a 2-
pole 2-zero compensator. However these can be of other forms such as, PI, PID, 3-pole 3-
zero or any other controller suitable for the application. The modular library structure makes
it convenient to visualize and understand the complete system software flow as shown in 图
5. It also allows for easy use and modifications of various functionalities. This fact is amply

demonstrated in this project by implementing an incremental build approach. This is
discussed in more detail in 3.2 节.
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图图 6. C2000 ILPFC Software Control Flow

As mentioned in 1 节, the IL PFC system is controlled by two feedback loops. The outer voltage loop
regulates the DC bus voltage, while a faster inner current loop shapes the input current in order to
maintain a high input power factor. 图 6 also shows the rate at which the software modules are executed.
For example, the current controller is executed at a rate of 100kHz (half of the PWM switching frequency)
while the voltage controller is executed at 50kHz rate.

3.2 Incremental Builds

The complete CCS project for ILPFC is divided into three incremental builds. This approach provides the
user with a step-by-step method to get familiar with the software and understand how it interacts with the
IL PFC hardware. This approach also simplifies the task of debugging and testing the boards.

The build options are shown in 表 2 . To select a particular build option set the parameter INCR_BUILD to
the corresponding build selection as shown. This parameter is found in InterleavedPFC-Settings.h file.
Once the build option is selected, compile the complete project by selecting rebuild-all compiler option.
Next chapter provides more details to run each of the build options.

表表 2. Incremental Build Options for PFC

INCR_BUILD = 1 Open loop test for boost PFC and ADC feedback (Check sensing circuitry)
INCR_BUILD = 2 Open voltage loop and closed current loop control of IL PFC
INCR_BUILD = 3 Closed voltage loop and closed current loop control of IL PFC
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3.3 Procedure for running the incremental builds

All software files related to this C2x controlled IL PFC system i.e., the main source files, ISR assembly
files and the project file for C framework, are located in the directory
…\controlSUITE\development_kits\ILPFC_v1.0\ILPFC. The projects included with this software are
targeted for CCSv4.

CAUTION

There are high voltages present on the board. It should only be handled by
experienced power supply professionals in a lab environment. To safely
evaluate this board an isolated AC source should be used to power up the unit.
Before AC power is applied to the board a voltmeter and an appropriate
resistive load (only) should be attached to the output. This will discharge the
bus capacitor quickly when the AC power is turned off. The board has not been
tested with electronic load and so it should not be used with such load. There is
no output over-current protection implemented on the board and so the user
should take appropriate measures for preventing any output short circuit
condition. The ILPFC board should always be started with 110Vac (60Hz).
Once the board is up and running the input voltage can be changed to any
other voltage within the specification.

Follow the steps in the following "Build..." sections to build and run the example included in the PFC
software.

3.3.1 Build 1: Open Loop Boost PFC with ADC

3.3.1.1 Objective

The objectives of this build are as follows:
1. Evaluate IL PFC PWM and ADC software driver modules
2. Verify MOSFET gate driver circuit, voltage, and current sensing circuit
3. Familiarize yourself with the operation of Code Composer Studio (CCS).

Under this build the system runs in open-loop mode and so the measured ADC values are used for circuit
verification and instrumentation purposes only. Steps required for building and running a project is
explained next.

3.3.1.2 Overview

The software in Build1 has been configured so that the user can quickly evaluate the PWM driver module
(software driver) by viewing the related waveforms on a scope and observing the effect of duty cycle
change on PFC output voltage. The user can adjust the PWM duty cycle from CCS watch window. The
user can also evaluate the ADC driver module (software driver) by viewing the ADC sampled data in the
CCS watch window. The PWM and ADC driver macro instantiations are executed inside the _DPL_ISR.
图 7 shows the software blocks used in this build. The two PWM signals for the two PFC switches are
obtained from ePWM module 1. ePWM1A drives one of the PFC switches while ePWM1B drives the
other.

The signals that are sensed and input to the MCU include the following:
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1. Line and neutral voltages (VL_fb, VN_fb)
2. PFC input current (Ipfc)
3. DC bus voltage (Vpfc).

These quantities are read using the ADC driver module and are indicated in 图 7. The ADC driver module
converts the 12-bit ADC result to a 32-bit Q24 value. A few lines of code in the ISR implements the
detection of input AC line half cycle (positive & negative half cycles) and the rectification of the input
voltage. This generates the input rectified signal Vrect.

图图 7. Build 1 Software Blocks

The PWM signals are generated at a frequency of 200 kHz i.e. a period of 5 us. With the controller
operating at 60MHz, one count of the time base counter of ePWM1 corresponds to 16.6667ns. This
implies a PWM period of 5us is equivalent to 300 counts of the time base counter (TBCNT1). The ePWM1
module is configured to operate in up-down count mode as shown in 图 8. This means a time base period
value of 150 (period register value) will give a total PWM period value of 300 counts (i.e. 5 us).

PFC total inductor current is sampled at the midpoint of the PWM ON pulse since the sampled value
represents the average inductor current under CCM (continuous conduction mode) condition. Under DCM
condition the sampled current value also represents an approximate average inductor current because of
the oversampling action. PFC inductor current is also oversampled 8 times during each 10 us time period
when both the PFC switches turn on once in their respective 5 us time slot (200kHz PWM). These 8
sampled values are then used to calculate the average PFC inductor current. This is illustrated in 图 8.

The voltage signal conversions are also initiated when the PFC switch is on. This is indicated in 图 8. The
flexibility of ADC and PWM modules on C2000 devices allow for precise and flexible ADC start of
conversions. In this case the time base counters (TBCNTx) of ePWM1~ePWM4 are used as 4 time bases
to generate all the start of conversion (SOC) triggers.
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图 8 shows 8 SOC triggers are generated when:
1. TBCNT1 reaches zero and period
2. TBCNT2 reaches the preset CMPA values during up and down count
3. TBCNT3 reaches zero and preset CMPB value during up count
4. TBCNT4 reaches preset CMPA and CMPB values during up count

Systems Applications Collateral A dummy ADC conversion is also performed at TBCNT3 zero point in
order to ensure the integrity of the ADC results.

图 8 also shows the PWM outputs generated using ePWM1 module. PFC current is converted, averaged
and then saved as Ipfc for PFC current loop control.

图图 8. PWM generation and ADC Sampling

All ADC results are read in the ISR by executing the ADC driver module from the 100kHz ISR labeled as
_DPL_ISR.
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This ISR in assembly (_DPL_ISR) is triggered by EPWM2 on a CMPB match event on up count. CMPB is
set to 80 so that the ISR is triggered only after the ADC conversions are complete. Inside the ISR
PWMDRV_2ch_UpDwnCnt macros are executed and the PWM compare shadow registers are updated.
These are loaded into the active register at the next TBCNT1 = ZERO event. Note that the ISR trigger
frequency is half that of the PWM switching frequency as shown in 图 8.
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3.3.1.2.1 Protection

An overvoltage protection mechanism is implemented in software for this IL PFC EVM.

The sensed DC bus output voltage from the ADC input is compared against the overvoltage protection
threshold set by the user. The OV threshold point for this ILPFC EVM has been set to 430V. This
threshold parameter is labeled as VBUS_OVP_THRSHLD inside the file InterleavedPFC-Settings.h. In
case of an OV condition the PWM outputs are shut off using the TZ (trip zone) registers. The flexibility of
the trip mechanism on C2000 devices provides the possibilities for taking different actions on different trip
events. In this project both PWM outputs will be driven low in case of a trip event. Both outputs are held in
this state until a device reset is executed.

3.3.1.3 Procedure

3.3.1.3.1 Start CCS and Open a Project

Follow these steps to execute this build:
1. Connect USB connector to the Piccolo controller board for emulation. Connect the 12V bias supply

output (external bias supply provided with the PFC EVM) to JP1 and apply this bias voltage to the
board by setting the switch SW1 to position “Ext”. By default, the Piccolo control card jumpers (see
Piccolo control card documentation) are configured such that the device boot from FLASH. Change
these jumper settings to allow code execution under CCS control.

2. Start Code Composer Studio (CCS). In CCS, a project contains all the files and build options needed
to generate an executable output file (.out) which can run on the MCU hardware. On the menu bar
click: Project -> Import Existing CCS/CCE Eclipse Project and under Select root directory navigate to
and select ..\controlSUITE\development_kits\ILPFC_v1.0\ILPFC directory. Make sure that under the
Projects tab ILPFC is checked. Click Finish. This project will invoke all the necessary tools (compiler,
assembler & linker) for building the project.

3. In the project window on the left, click the plus sign (+) to the left of Project. Your project window will
look like the following in 图 9:

http://www.ti.com.cn
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图图 9. CCS Project Window

3.3.1.3.2 Device Initialization, Main, and ISR Files

注注: Do not make any changes to the source files - Only Inspect

1. Open and inspect InterleavedPFC-DevInit_F2803x.c by double clicking on the filename in the project
window. Note that system clock, peripheral clock prescale, and peripheral clock enables have been
setup. Next, notice that the shared GPIO pins have been configured.

2. Open and inspect InterleavedPFC-Main.c. Notice the call made to DeviceInit() function and other
variable initialization. Also notice code for different incremental build options, the ISR initialization and
the background for(;;) loop.

3. Locate and inspect the following code in the main file under initialization code specific for build 1. This
is where the PWMDRV_2ch_UpDwnCnt and ADCDRV_1CH blocks are connected in the control flow.
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4. Locate and inspect the following code in the main file under initialization code. This is where the
PWMDRV_2ch_UpDwnCnt block is configured and initialized. This is common for all incremental
builds. This PWM driver module inputs the total PWM period value of 300 and internally calculates the
period register value of 150.
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5. Also locate and inspect the following code in the main file under initialization code. This is where the
ADCDRV_1CH block is configured and initialized. This is also common for all incremental builds.
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6. Open and inspect InterleavedPFC-DPL-ISR.asm. Notice the _DPL_Init and _DPL_ISR sections under
build 1. This is where the PWM and ADC driver macro instantiation is done for initialization and
runtime, respectively.

3.3.1.3.3 Build and Load the Project
1. Select the incremental build option as 1 in the InterleavedPFC-Settings.h file.

注注: Whenever you change the incremental build option in InterleavedPFC-Settings.h, always do
a "Rebuild All".

2. Click Project -> “Rebuild All” button and watch the tools run in the build window.
3. Click Target ->”Debug Active Project”. CCS will ask you to open a new Target configuration file if one

hasn’t already been selected. If a valid target configuration file has been created for this connection
you may jump to 节 3.3.1.3.4. In the New target Configuration Window type in the name of the .ccxml
file for the target you will be working with (Example: xds100-F28035.ccxml). Check “Use shared
location” and click Finish.

4. In the .ccxml file that open up select Connection as “Texas Instruments XDS100v2 USB Emulator” and
under the device, scroll down and select “TMS320F28035”. Click Save.

5. Click Targe -> -> ”Debug Active Project”. Select project configuration as F2803x_FLASH. The program
will be loaded into the FLASH. You should now be at the start of Main().

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDU249.pdf


Software Overview www.ti.com.cn

18 ZHCU189–April 2014

TIDU249 — http://www-s.ti.com/sc/techlit/TIDU249
版权 © 2014, Texas Instruments Incorporated

具有功率计量测试结果的两相交错式 PFC 转换器

3.3.1.3.4 Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There are various
methods for doing this in Code Composer Studio, such as memory views and watch views. If a watch view
did not open when the debug environment was launched, open a new watch view and add various
parameters to it by following the procedure given below.
1. Click View -> Watch on the menu bar.
2. Click the “Watch (1)" tab at the top watch view. You may add any variables to the watch view. In the

empty box in the "Name" column, type the symbol name of the variable you want to watch and press
enter on keyboard. Be sure to modify the “Format” as needed. The watch view should look something
like the following in 图 10

图图 10. CCS Watch View for Build 1

3.3.1.3.5 Using Real-Time Emulation

Real-time emulation is a special emulation feature that allows the windows within Code Composer Studio
to be updated at a rate up to 10 Hz while the MCU is running. This not only allows graphs and watch
views to update, but also allows the user to change values in watch or memory windows, and see the
effect of these changes in the system. This is very useful when changing control law parameters on-the-
fly, for example.
1. Enable real-time mode by hovering your mouse on the buttons on the horizontal toolbar and clicking

button.
2. A message box may appear. If so, select YES to enable debug events. This will set bit 1 (DGBM bit) of

status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit. When the DGBM bit is set to
“0”, memory and register values can be passed to the host processor for updating the debugger
windows.

3. Click on Continuous Refresh buttons for the watch view.
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3.3.1.3.6 Run the Code
1. Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target -> Run on

the menu bar.
2. In the watch view, add the variable DutyA and set it to 0.1 (=1677721 in Q24). This variable sets the

duty cycle for the PFC converter.
3. Apply an appropriate resistive load to the PFC system at the DC output (8k/20W, or, 4K/40W or,

2k/80W).
4. Slowly apply AC Power to the board. Measure and verify the DC bus voltage corresponding to applied

input voltage and the duty ratio.
5. Use DutyA to slowly change the duty from the watch window. The boost converter output voltage

should change accordingly.

注注: Observe the output voltage carefully, the output voltage should not be allowed to exceed the
maximum voltage rating of the board (400V).

6. Add the other variables such as, Vbus, VL_fb, VN_fb and verify the different ADC results in the watch
view. For AC voltage input the sensed line and neutral voltage(VL_fb, VN_fb) will vary continuously in
the watch window. Therefore, to verify the ADC readings and the line and neutral voltage sense
circuits, the user may apply DC input voltage (20~200V) instead of AC (as stated in Step 4). In that
case the PFC stage will temporarily operate in a pure dc-dc boost mode. CCS watch window below
shows some of the variables under Build 1 when the input AC voltage is about 90Vrms, open loop duty
is 10%, DC bus resistive load is about 4K ohm and DC bus voltage is 200V. Notice the Q-format used
for each variable. Under this condition first four variables in the watch window show the AC line
frequency, the RMS input voltage, the DC bus voltage and the RMS input current. The variable
Gui_PinRMS shows the input power.

7. The following oscilloscope capture shows two PWM outputs (Ch1 & Ch2) with duty ratio set to 10%.
The PWM frequency is measured to be 200kHz.
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8. Try different duty cycle values and observe the corresponding ADC results. Increase duty cycle value
in small steps. Always observe the output voltage carefully, this should not be allowed to exceed the
capabilities of the board. Different waveforms, like the PWM gate drive signals, input voltage and
current and output voltage may also be probed and verified using an oscilloscope. Appropriate safety
measures must be taken while probing these high voltage signals.

9. Fully halting the MCU when in real-time mode is a two-step process. With the AC input turned off wait
until the DC bus capacitor is fully discharged. First, halt the processor by using the Halt button on the
toolbar, or by using Target -> Halt. Then take the MCU out of real-time mode. Finally reset the MCU.

10. You may choose to leave Code Composer Studio running for the next exercise or optionally close
CCS.

11. End of Exercise

3.3.1.4 Build 2: IL PFC with Closed-Current Loop

3.3.1.4.1 Objective

The objective of this build is to verify the operation of the IL PFC under closed current loop mode.

3.3.1.4.2 Overview

图 11 shows the software blocks used in this build. Notice that 1 additional software blocks are added to
the Build 1 diagram (图 7) to implement this closed current loop system. The Sine Analyzer block
calculates the RMS voltage and frequency of the input voltage. PFC InvRmsSqr block calculates the
inverse of the square of the RMS input voltage. This calculated value together with the rectified voltage
(Vrect) is used in the software block PFC_ICMD to generate the reference current command PfcIcmd for
the PFC current control loop. PFC_ICMD block uses a 3rd input VpfcVcmd for controlling the magnitude of
the reference current command. Since this software build implements only the PFC current loop (open
voltage loop), this parameter VpfcVcmd needs to be varied from the CCS watch window in order to adjust
the magnitude of the reference current and hence the PFC bus voltage. A two pole two zero (2p2z)
controller is used to implement the current control loop. This is the 4th software block shown in 图 11 as
CNTL_2P2Z:1. Depending on the control loop requirements other control blocks such as a PI or a 3p3z
controller can also be used.

As shown in 图 11 the current loop control block is executed at a 100 KHz rate. CNTL_2P2Z is a 2nd
order compensator realized from an IIR filter structure. This function is independent of any peripherals and
therefore does not require a CNF function call.
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图图 11. Build 2 Software Blocks

This 2p2z controller requires five control coefficients. These coefficients and the clamped output of the
controller are stored as the elements of a structure named CNTL_2P2Z_CoefStruct1. The CNTL_2P2Z
block can be instantiated multiple times if the system needs multiple loops. Each instance can have
separate set of coefficients. The CNTL_2P2Z instance for the current loop uses the coefficients stored as
the elements of structure CNTL_2P2Z_CoefStruct1. This way a second instantiation of CNTL_2P2Z with a
different structure, CNTL_2P2Z_CoefStruct2, can be used for PFC voltage loop control, as we will see in
节 3.3.1.4.4 with Build 3.

The controller coefficients can be changed directly by modifying the values for B0, B1, B2, A1, and A2
inside the structure CNTL_2P2Z_CoefStruct1. Alternately, the 2p2z controller can be expressed in PID
form and the coefficients can be changed by changing the PID coefficients. The equations relating the five
controller coefficients to the three PID gains are given below. For the current loop these P, I and D
coefficients are named as: Pgain_I, Igain_I and Dgain_I respectively. For the voltage loop, used in Build 3,
these coefficients are named as: Pgain_V, Igain_V and Dgain_V respectively. These coefficients are used
in Q26 format.

The compensator block (CNTL_2P2Z) has a reference input and a feedback input. The feedback input
labeled as, Fdbk, comes from the ADC. The reference input labeled as, Ref, comes from PFC_ICMD
block as mentioned before. The z-domain transfer function for CNTL_2P2Z is given by:

(1)
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The recursive form of the PID controller is given by the difference equation:

where

• (2)

And the z-domain transfer function of this PID is:

(3)

Comparing this with the general form, we can see that PID is a special case of CNTL_2P2Z control where:
(4)

The MATH_EMAVG (Exponential Moving Average) block calculates the average of the output DC bus
voltage. The output from this block is used to detect overvoltage condition followed by a PWM shutdown.

3.3.1.4.3 Procedure

Follow the following steps to execute this build:

3.3.1.4.3.1 Build and Load Project

Follow the steps below to execute this build:

Follow the steps in 节 3.3.1.3.2 exactly as in build 1(节 3.3.1) except that in Step 6, select build 2 option
instead of build 1. Then complete Step 6 as below:
1. Locate and inspect the following code in the main file under initialization code specific for build 2. This

is where all the software blocks related to build 2 are connected in the control flow.

2. Open and inspect InterleavedPFC-DPL-ISR.asm. Notice the _DPL_Init and _DPL_ISR sections under
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build 2. This is where all the macro instantiations under build 2 are done for initialization and runtime,
respectively.

3. Select the Incremental build option as 2 in the InterleavedPFC-Settings.h file. Then follow the steps in
节 3.3.1.3.3 as in build 1 in order to run the code. When all these steps are completed you should now
be at the start of Main().

注注: Whenever you change the incremental build option in InterleavedPFCSettings.h always do a
“Rebuild All”

4. Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target -> Run on
the menu bar.

5. In the watch view, add the variable VpfcVcmd and set it to 0.025 (=419430 in Q24). This variable sets
the magnitude of the reference current command for the current control loop.

6. Apply an appropriate resistive load to the PFC system at the DC output. For example, a 8.0Kohm
resistor of 40W rating can be used. This will provide a load of 18W at 380V bus voltage.

7. Slowly apply AC Power to the board from an isolated AC source. Monitor the DC bus voltage as the
input voltage is raised slowly to 82V rms. The bus voltage now should be around 380V. Use a current
probe to observe the input current. With 82V rms input, 8.0kohm resistive load and bus voltage set to
380V you should see the following waveforms. Here Ch4 is the input current, Ch1/Ch2 are the PWM
outputs. With the current loop closed the input current should have the same shape of the input voltage
with good power factor.

CCS watch window below shows some of the variables under Build 2 when the input AC voltage is
about 82Vrms, VbusVcmd is set to 0.025, DC bus resistive load is about 8K ohm and DC bus voltage
is 380V.
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8. Increase VpfcVcmd slightly (in steps of 0.002) and observe the bus voltage settles to a higher value.
Increasing VpfcVcmd increases the magnitude of the current reference signal and, since the PFC
voltage loop is open, the bus voltage will rise. Therefore, apply caution and set the overvoltage
protection threshold to 400V. This threshold parameter is labeled as VBUS_OVP_THRSHLD inside
the file InterleavedPFC-Settings.h. The default value is set to 430V. Now change the input voltage or
the load resistance to see the PFC operation under current control loop.

9. Fully halting the MCU when in real-time mode is a two-step process. With the AC input turned off wait
until the DC bus capacitor is fully discharged. First, halt the processor by using the Halt button on the
toolbar, or by using Target -> Halt. Then take the MCU out of real-time mode. Finally reset the MCU.

10. You may choose to leave Code Composer Studio running for the next exercise or optionally close
CCS.

11. End of Exercise

3.3.1.4.4 Build 3: IL PFC with Closed Voltage and Current Loop

3.3.1.4.4.1 Objective

The objective of this build is to verify the operation of the complete IL PFC project from the CCS
environment.

3.3.1.4.4.2 Overview

图 12 shows the software blocks used in this build. Compared to build 2 in 图 11 this build uses an
additional 2p2z control block labeled as CNTL_2P2Z:2. This is the 2nd instantiation of the 2p2z control
block in order to implement the IL PFC voltage loop control. This voltage loop controller is executed at
50kHz rate which is half the rate for current loop. The output from this control block drives the input node
VpfcVcmd of the PFC_ICMD block. This is the main difference compared to build 2 where VpfcVcmd is
updated by user from CCS watch window in an open voltage loop mode.

图图 12. Build 3 Software Blocks
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Similar to current loop controller, this voltage loop controller, CNTL_2P2Z:2, also requires five control
coefficients. These coefficients and the clamped output of the controller are stored as the elements of a
2nd structure named CNTL_2P2Z_CoefStruct2. The coefficients for this controller can be changed directly
by modifying the values for B0, B1, B2, A1, and A2 inside the structure CNTL_2P2Z_CoefStruct2, or by
changing the equivalent PID gains as discussed in 节 3.3.1.4.

3.3.1.4.4.2.1 Start-Up, Inrush Current Control, and Slew-Limit

At start-up, the controller monitors the PFC DC bus voltage. When this voltage reaches a minimum level
(this min level for this ILPFC EVM is set around 160Vdc) PFC action is enabled and the output DC bus
slowly ramps up to the pre-set value of about 390Vdc. This output voltage level is set by the constant
VBUS_RATED_VOLTS defined in the PFC header file InterleavedPFC-Settings.h. The ramp up speed is
set by the parameter VbusSlewRate defined and implemented in the soft-start state machine task C2. This
part of the software can be quickly modified to implement any other desired mode for PFC start-up.

3.3.1.4.4.2.2 Input Power Monitor

This ILPFC EVM has been equipped with input power monitoring feature. All the calculation for input
power measurement is done inside a 10kHz ISR running the SineAnalyzer macro (图 12). This macro
block takes the rectified input voltage and the rectified input current as its inputs. Then based on this
information it calculates the RMS input power, RMS input voltage and RMS input current using the
following equations:

(5)

The time period T of the rectified input voltage and current is calculated by setting a low threshold voltage
level for the rectified voltage signal and then by measuring the time between the consecutive points when
the signal crosses this threshold level. This is illustrated in 图 13.

http://www.ti.com.cn
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图图 13. RMS Input Voltage and Current Calculation Scheme

3.3.1.4.4.2.3 Procedure

3.3.1.4.4.2.4 Build and Load Project

Follow the steps below to execute this build.

Follow the steps in 节 3.3.1.3.1 exactly as in build 1(节 3.3.1) except that in Step 6 select build 3 option
instead of build 1. Then complete Step 6 as below:
1. Locate and inspect the following code in the main file under initialization code specific for build 3. This

is where all the software blocks related to build 3 are connected in the control flow.

http://www.ti.com.cn
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2. Open and inspect InterleavedPFC-DPL-ISR.asm. Notice the _DPL_Init and _DPL_ISR sections under
build 3. This is where all the macro instantiations under build 3 are done for initialization and runtime,
respectively.

3. Select the Incremental build option as 3 in the InterleavedPFC-Settings.h file. Then follow steps in 节
3.3.1.3.3 and 节 3.3.1.3.5 as in build 1 in order to run the code. When all these steps are completed

you should now be at the start of Main().

注注: Whenever you change the incremental build option in InterleavedPFC-Settings.h always do a
"Rebuild All"

4. Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target -> Run on
the menu bar.

5. In the watch view, add the variables VbusTargetSlewed, Vbus and set the Q-format to Q24. These
variables represent the p.u. reference bus voltage and the feedback bus voltage respectively
(normalized or per unit values). These will slowly increase to the setpoint value as the PFC starts up
when AC power is applied.

6. Apply an appropriate resistive load to PFC output. For example, a 8.0Kohm resistor of 40W rating can
be used. This will provide a load of about 20W at 390V bus voltage. Configure the isolated AC source
to output 120V, 60Hz, AC voltage output. Use a voltmeter to monitor the DC bus voltage. Turn on the
AC source output for 120Vrms. When the DC bus voltage reaches 160V, PFC action will start and the
bus voltage will slowly increase to about 390V. Notice that VbusTargetSlewed and Vbus variables on

http://www.ti.com.cn
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the watch window show a value of about 0.7414 (=390/526) when the Q format is set to Q24. The
maximum bus voltage set by the Vbus sense resistors is about 526V that corresponds to maximum
ADC input of 3.3V. Therefore, the normalized or per unit value will be about 0.7414 when the actual
bus voltage is 390Vdc. CCS watch window below shows some of the variables under Build 3 when the
input AC voltage is about 120Vrms, DC bus resistive load is about 8K ohm and DC bus voltage is
about 390V. The variable “pfc_on_flag” is set to 1 when the soft-start is complete and PFC bus voltage
reaches the desired set point. Use an oscilloscope with voltage and current probes to observe the
input voltage and input current. With 110Vrms input, 277 ohm resistive load and bus voltage set to
390V you should see the waveforms shown below. Here Ch2 is the input voltage and Ch4 is the input
current. Change the input voltage (100Vrms~260Vrms) or the load resistance (0~550W @110Vin, or,
0~700W @220Vin) to see the PFC operation under closed current and voltage control loop.

图图 14. IL PFC Input Voltage and Current at 550W Load and 110Vrms Input

7. Fully halting the MCU when in real-time mode is a two-step process. With the AC input turned off wait
until the DC bus capacitor is fully discharged. First, halt the processor by using the Halt button on the
toolbar, or by using Target -> Halt. Then take the MCU out of real-time mode. Finally reset the MCU.

8. You may choose to leave Code Composer Studio running for the next exercise or optionally close
CCS.

9. End of Exercise
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3.3.1.4.4.3 Additional Test Results

(1) Ch3 -Vin, Ch4-lin, Vrms=230V, Vbus=390V, Pout=700W

图图 15. IL PFC Input Voltage and Current Waveforms

Ch3 –Vin, Ch4-Iin, Vrms=230V, Vbus=390V, Pout=375W
图图 16. IL PFC Input Voltage and Current Waveforms

Ch1-Vbus, Ch4-lin, Vrms = 120V, Vbus = 390V,
Load Step 360W ~ 520W

图图 17. IL PFC DC Bus Load Transient Response

Ch3-Vin, Ch4-lin, Vrms = 230V, Vbus = 390V, Pout = 80W
图图 18. IL PFC Input Voltage and Current Waveforms

Ch1-Vbus, Ch4-lin, Vrms = 220V, Vbus = 390 V,
Load Step 370W ~ 530W

图图 19. IL PFC DC Bus Load Transient Response
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4 References

For more information, please refer to the following guides:

ILPFC-GUI_QSG— A quick-start guide for quick demo of the ILPFC EVM using a GUI interface.

..\controlSUITE\development_kits\ILPFC\~Docs\ILPFC-GUI_QSG.pdf

ILPFC_Rel-1.0-HWdevPkg— A folder containing various files related to the Piccolo-B controller card
schematics and the IL PFC schematic.

..\controlSUITE\development_kits\ILPFC\ILPFC_HWDevPkg

F28xxx User's Guides— http://www.ti.com/f28xuserguides

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDU249.pdf
http://www.ti.com/f28xuserguides
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